
Podział hydrograficzny zlewni Liwca przyjęto wg cyfrowej mapy MPHPf  
w skali 1:50 000 (Czarnecka i in. 2006, 2010). Została ona wykonana w Ośrodku 
Zasobów Wodnych IMGW na zamówienie Ministra Środowiska i sfinansowana ze 
środków NFOŚiGW. W monografii mapa posłużyła do określenia granicy zlewni 
Liwca, w obrębie której prowadzono analizy przestrzenne.

Zastosowany w pracy numeryczny model terenu SRTM w wersji 4 pozyskano  
z bazy danych CGIAR-CSI (ang. Consortium for Spatial Information of the Consulta-
tive Group for International Agricultural Research) (Jarvis i in. 2008). Model wyko-
nany jest w rozdzielczości przestrzennej 3”, co odpowiada ok. 90 m na równiku (Farr 
i in. 2007). Udostępniany jest w plikach zawierających dane dla obszaru o powierzch-
ni 5°×5° długości i szerokości geograficznej. Pozyskano plik w formacie rastrowym 
GeoTiff z danymi reprezentującymi obszar 50-55°N i 20-25°E. Dane zapisane są  
w układzie odniesienia WGS84. Wielkość komórki rastra wynosi 76,2×76,2 m.

Numeryczny model terenu SRTM wykorzystano w analizie przestrzenne-
go zróżnicowania uwilgotnienia strefy aeracji, przy opracowaniu topograficznego 
wskaźnika wilgotności TWI oraz jego modyfikacji, jak również przy podziale zlew-
ni na strefy wysokościowe w modelu HBV. Numeryczny model terenu zlewni Liwca 
przedstawia rys. 3.2, zamieszczony w rozdz. 3.1.

W pracy wykorzystano również mapę glebowo-rolniczą w wersji cyfrowej  
w skali 1:25 000. Pierwotna wersja mapy była opracowana w latach sześćdziesią-
tych i siedemdziesiątych XX w. przez Instytut Uprawy, Nawożenia i Gleboznawstwa 
IUNG w Puławach (Strzemski i in. 1973). Jej treść stanowią kompleksy rolniczej 
przydatności gleb, typy, podtypy oraz gatunki gleb. Mapę wykonano zgodnie z obo-
wiązującą wówczas klasyfikacją gleb i utworów mineralnych Polskiego Towarzy-
stwa Gleboznawczego (PTG 1956). Wersję cyfrową mapy wykonano na podstawie 
map pierwotnych oraz wielospektralnych zdjęć satelitarnych, które posłużyły do 
aktualizacji użytkowania i zasięgu gruntów na rok 2006. Mapa ma postać warstwy 
wektorowej, zapisanej w układzie współrzędnych 1992. W tabeli atrybutów warstwy 
znajdują się dane tekstowe o poligonach, dotyczące m.in. typu i podtypu gleby, kom-
pleksu przydatności rolniczej oraz gatunku gleby w warstwach 0-25, 25-50, 0-50, 
50-100 i 100-150 cm.

Dla ok. 99% powierzchni zlewni znajdującej się w województwie mazowiec-
kim mapę pozyskano z zasobów Departamentu Geodezji i Kartografii Urzędu Mar-
szałkowskiego Województwa Mazowieckiegog. Dla niewielkiego fragmentu zlewni 

f MPHP została udostępniona przez Zakład Hydrologii Wydziału Geografii i Studiów Regionalnych 
Uniwersytetu Warszawskiego.
g Mapę zakupiono dla 7 powiatów w 2 transzach na podstawie zamówień z 13.08.2009 r. i 06.12.2010 r.
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o powierzchni ok. 22 km2, należącego do województwa lubelskiego, mapę pozy-
skano z IUNG w Puławachh. Mapa glebowo-rolnicza zawiera dane dla obszarów 
użytkowanych rolniczo oraz lasów prywatnych.

Informacje o uziarnieniu gleb leśnych zostały uzupełnione z leśnej mapy nume-
rycznej (LMN), która stanowi bazę danych przestrzennych o lasach państwowych 
(Okła 2010). Jest ona połączona z bazą danych opisowych, którą jest System In-
formatyczny Lasów Państwowych (SILP). Źródłem informacji o glebach dla LMN 
są mapy glebowo-siedliskowe wykonywane w nadleśnictwach w skali 1:5000. Ich 
treść obejmuje m.in. typy, podtypy, rodzaje i gatunki gleb oraz typy siedliskowe 
lasu. Mapy glebowo-siedliskowe opracowywane są na podstawie prac kameral-
nych i terenowych zgodnie z obowiązującą instrukcją urządzania lasu. Fragment 
leśnej mapy numerycznej w postaci warstwy wektorowej w układzie współrzędnych 
1992 pozyskano z Regionalnej Dyrekcji Lasów Państwowych w Warszawiei. Obej-
muje on obszar czterech Nadleśnictw: Łochów, Mińsk, Siedlce i Sokołów. Typy, 
podtypy oraz gatunki gleb określone są wg klasyfikacji Polskiego Towarzystwa 
Gleboznawczego z 1989 r. (PTG 1989). Przedziały średnic poszczególnych frakcji  
i podfrakcji oraz podział na podgrupy granulometryczne odpowiadają tym z klasy-
fikacji z 1956 r. (PTG 1956), wg której zostały wykonane mapy glebowo-rolnicze  
w skali 1:25000.

Mapę glebowo-rolniczą zintegrowaną z leśną mapą numeryczną wykorzystano 
w analizie zróżnicowania przestrzennego uziarnienia gleb oraz w ocenie możliwo-
ści retencjonowania wody, przy opracowywaniu zmodyfikowanej wersji wskaźni-
ka TWI. Ponadto mapy posłużyły do zobrazowania zróżnicowania uziarnienia gleb  
w zlewni Liwca (rys. 3.3 i 3.4, rozdz. 3.1).

Dane przestrzenne o pokryciu terenu pochodzą z europejskiego projektu CORI-
NE Land Cover CLC2006 (Bielecka, Ciołkosz 2009). Szczegółowość danych odpo-
wiada mapie w skali 1:100000. Powierzchnia najmniejszego wydzielenia jest rów-
na 25 ha, a jego szerokość wynosi co najmniej 100 m. Mapa w postaci wektorowej  
w układzie współrzędnych 1992 została udostępniona przez Główny Inspektorat 
Ochrony Środowiskaj. Dane CLC2006 zostały wykorzystane w celu zobrazowania po-
krycia terenu oraz w ocenie użytkowania ziemi w zlewni Liwca (rys. 3.5, rozdz. 3.1).

W pracy wykorzystano również dane przestrzenne wskaźnika LAI, opracowa-

h Mapę zakupiono na podstawie zamówienia z 28.06.2011 r.
i Mapa została udostępniona na podstawie wniosku do Regionalnej Dyrekcji Lasów Państwowych  
w Warszawie z 20.09.2012 r.
j Dane zostały udostępnione na podstawie wniosku do Głównego Inspektora Ochrony Środowiska  
z 18.02.2012 r.
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ne na podstawie obrazów satelitarnych wykonywanych za pomocą spektroradiome-
tru MODIS (ang. Moderate Resolution Imaging Spectroradiometer) umieszczonego 
na satelicie Terra (EOS AM-1) (Myneni i in. 2003). Mapy wskaźnika LAI są za-
warte w zestawie danych MOD15A2. Algorytm obliczania LAI opisali Knyazikhin 
i in. (1999). Wskaźnik wyrażony jest w m2 roślinności na m2 powierzchni gruntu. 
Dane są dostępne od lutego 2000 r. w 8-dniowym kroku czasowym. Rozdzielczość 
przestrzenna danych wynosi 1000 m. Udostępniane są one w formacie HDF (ang. 
Hierarchical Data Format) w arkuszach o wymiarach 10º×10º długości i szerokości 
geograficznej. Dane mają odwzorowanie sinusoidalne.

Mapy wskaźnika LAI pobrano ze strony internetowej centrum przetwarzania, 
gromadzenia i dystrybucji danych LP DAAC (ang. Land Processes Distributed Acti-
ve Archive Center), należącej do Systemu Obserwacji Ziemi EOS NASAk. Obejmo-
wały one okres od maja do października 2010 r. Dla każdego terminu pobrano plik 
zawierający dane dla obszaru środkowej i wschodniej Polski, oznaczony symbolem 
h19v03. Łącznie pozyskano 23 pliki. Mapy wskaźnika LAI zostały wykorzystane 
przy opracowywaniu zmodyfikowanej wersji wskaźnika TWI.

Zebrane materiały stanowią bazę danych przestrzennych o obszarze badań. Przy 
przetwarzaniu zbiorów posłużono się technikami analizy przestrzennej z wykorzysta-
niem programu ArcGIS w wersji 10. Analizy prowadzono w układzie współrzędnych 
1992 w domenie przestrzennej obejmującej zlewnię Liwca i obszary sąsiadujące.

3.3. Metody badawcze
3.3.1. Metodyka badań terenowych

Badania eksperymentalne uwilgotnienia gleby, jak wspomniano w rozdz. 3.2.1, 
prowadzono w sześciu stanowiskach badawczych w osiemnastu terminach pomia-
rowych. Pomiary wilgotności objętościowej gleby w profilu glebowym wykonywa-
no automatycznie przenośnym miernikiem FOM/mts (ang. Field Operated Meter/
soil moisture, temperature, salinity), opracowanym i wyprodukowanym w Instytu-
cie Agrofizyki Polskiej Akademii Nauk w Lublinie pod marką East Test (Skieru-
cha, Malicki 2004; Skierucha, Wilczek 2007). Urządzenie to działa na podstawie 
metody reflektometrii czasowej TDR, w której wykorzystuje się zależność pręd-
kości propagacji impulsu elektromagnetycznego od przenikalności dielektrycznej 
badanego osadu. Przenikalność dielektryczna ε jest miarą zachowania się cząstek 
materii po przyłożeniu zewnętrznego, zmiennego pola elektrycznego. Cząsteczki 

k Adres strony internetowej LP DAAC: https://lpdaac.usgs.gov/get_data (16.02.2012 r.).
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wody są podatne na wpływ pola elektrycznego z powodu budowy dipolowej – nie-
symetrycznego rozkładu ładunków (Skierucha 2005). Zatem przenikalność dielek-
tryczna wody ma znacznie większą wartość niż pozostałe składniki gleby. Dla wody 
wynosi ona ok. 81, dla fazy stałej ok. 4, dla powietrza ok. 1. Obliczając przenikal-
ność dielektryczną gleby, można w sposób pośredni ocenić ilość wody znajdującej 
się w glebie (Skierucha 2005). Przenikalność dielektryczna jest wyliczana na pod-
stawie pomiaru czasu propagacji impulsu elektromagnetycznego wzdłuż falowodu, 
utworzonego z dwóch równoległych prętów sondy, które umieszcza się w glebie. 
Następnie jest ona przeliczana na wilgotność objętościową zgodnie z empiryczną 
metodą zaproponowaną przez Malickiego i in. (1996):

gdzie: θ – wilgotność objętościowa [cm3·cm-3], ε – przenikalność dielektryczna [F·m-1], 
ρ – gęstość fazy stałej w stanie suchym [g·m-3].

Urządzenie zbudowane jest z jednostki centralnej, w której znajduje się gene-
rator impulsu elektromagnetycznego oraz z przewodu i czujnika, którymi przesy-
łany jest impuls. Czujniki, składające się z dwóch równoległych, nieizolowanych 
metalowych prętów, wprowadzane są podczas pomiaru do gleby. Pomiar trwa kilka 
sekund, a wartości można odczytać na wyświetlaczu. Wilgotność objętościowa gle-
by podawana jest w procentach w zakresie od 0 do 100%, z dokładnością do 0,1%. 
Błąd pomiaru wynosi ± 2% (Instrukcja obsługi… 2008). Rysunek 3.10 przedstawia 
schemat budowy urządzenia pomiarowego.

Przed przystąpieniem do pomiarów w danym terminie sonda była kalibrowa-
na zgodnie z Instrukcją obsługi… (2008). W pierwszym kroku wyznaczano auto-
matycznie długość sondy, czyli długość przewodu między jednostką centralną  
a czujnikami. Następnie sondę umieszczano kolejno w dwóch ośrodkach o różnych 
wartościach przenikalności dielektrycznej – powietrzu (ε = 1) oraz w wodzie demi-
neralizowanej (ε = 81).

θ = 
ε0,5 – 0,819 – 0,168ρ – 0,159ρ2

7,17 + 1,18ρ (3.3)

Rys. 3.10. Schemat urządzenia FOM/mts
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Pomiary wilgotności objętościowej w profilach glebowych wykonywano 
na głębokościach 5 cm i 10 cm, a następnie co 10 cm. Głębokość profili Sinołęka  
i Grochów wynosiła 120 cm, profilu Świniary – 70 cm, a głębokość profili Łączka, 
Popielów i Bednarze była uzależniona od poziomu występowania zwierciadła wody 
podziemnej. Profile pomiarowe były każdorazowo zasypywane, a podczas kolejnej 
sesji pomiarowej ponownie odkopywane. Za każdym razem odkrywka była wydłu-
żana od strony badanego profilu glebowego w celu odświeżenia ściany odkrywki.

Wyniki pomiarów terenowych wilgotności objętościowej profili glebowych 
przedstawiono w formie wykresów, a także scharakteryzowano wartościami średni-
mi oraz współczynnikami zmienności. Na podstawie wszystkich terminów pomiaro-
wych obliczono średnią wilgotność objętościową poszczególnych profili glebowych, 
a także średnią wilgotność wszystkich profili na poszczególnych głębokościach. Wy-
korzystano następujące równania, wcześniej stosowane przez Qiu i in. (2001a, b):

gdzie: θi,j,t – wilgotność objętościowa w profilu pomiarowym i na głębokości  
j w terminie pomiarowym t [%], θi – średnia wilgotność objętościowa w profilu 
pomiarowym i na podstawie wszystkich terminów pomiarowych [%], θj – średnia 
wilgotność objętościowa wszystkich profili pomiarowych na głębokości j na pod-
stawie wszystkich terminów pomiarowych [%], Np – liczba profili pomiarowych [-], 
Nw – liczba głębokości, na których był wykonywany pomiar [-], Nt – liczba terminów 
pomiarowych [-].

Na podstawie wszystkich terminów pomiarowych obliczono również średnią 
wartość uwilgotnienia poszczególnych profili glebowych na danej głębokości:

gdzie: θi,j – średnia wilgotność objętościowa w profilu pomiarowym i na głębokości j [%].
Współczynniki zmienności uwilgotnienia profilu glebowego i na głębokości  

j obliczono jako iloraz odchylenia standardowego i wartości średniej wg równania:
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θi =  θi,j,t  
1 Nw Nt

j =1 t =1
∑∑Nw × Nt

θj =  θi,j,t  
1 Np Nt

i =1 t =1
∑∑Np × Nt

θi,j =  θi,j,t  
1 Nt

t =1
∑Nt

(3.4)

(3.5)

(3.6)

(3.7)
Nt ∑Nt

i =1 (θi,j,t)2 – (∑Nt
i =1 θi,j,t)2

Nt(Nt – 1)
CVi,j = 

1 

θi,j 



Na podstawie wilgotności objętościowej zmierzonej w terenie obliczono za-
soby wodne strefy aeracji wyrażone miarą bezwzględną, w milimetrach warstwy 
wody. W tym celu wykorzystano opisane poniżej równania ogólne i szczegółowe, 
stosowane przez Somorowską (2004, 2006). Zapas wody w profilu glebowym moż-
na wyrazić wzorem:

gdzie: WS – zapas wody [mm]; θ – wilgotność objętościowa gleby [%]; Δz – miąższość 
profilu glebowego [cm].

Dysponując danymi wilgotności objętościowej z różnych głębokości profilu, 
zapas wody w całym profilu bądź w jego części można obliczyć jako sumę zapasów 
poszczególnych warstw gleby zgodnie z równaniem:

gdzie: WSm – zapas wody w warstwie m [mm], θm – średnia wilgotność objętościowa 
gleby warstwy m [%], Δzm – miąższość warstwy m [cm].

Na podstawie powyższych równań opracowano równania szczegółowe,  
wg których obliczono zapas wody w warstwach gleby: 0-10, 0-20, 0-30, 0-50 oraz 
0-70 cm:

gdzie: WS0-10 cm, WS0-20 cm, WS0-30 cm, WS0-50 cm, WS0-70 cm – zapas wody w warstwach pro-
filu podanych w indeksach dolnych [mm], θ5, θ10, θ20, θ30, θ40, θ50, θ60, θ70 – wilgot-
ność objętościowa na głębokościach podanych w indeksach dolnych w cm [%].

Zebrane podczas badań terenowych dane zobrazowano w formie rysunków  
i wykresów. Jedną z form prezentacji stanowią chronoizoplety wilgotności. Są one 
zazwyczaj wykreślane za pomocą prostych metod interpolacji liniowej. W tym przy-
padku zastosowano metodę krigingu zwykłego. Interpolację wykonano na zbiorze 
punktów reprezentujących pomiary w kolejnych warstwach profilu w każdym termi-
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WS = θ · ∆z
10 (3.8)

(3.9)

(3.10)

(3.11)

(3.12)

(3.13)

(3.14)

WS = 
θm · ∆zm

10WSm = ∑ ∑
n

m=1

n

m=1

WS0-10 cm = 0,75θ5 + 0,25θ10

WS0-20 cm = 0,75θ5 + 0,75θ10 + 0,5θ20

WS0-30 cm = 0,75θ5 + 0,75θ10 +  θ20 + 0,5θ30

WS0-50 cm = 0,75θ5 + 0,75θ10 +  θ20 +  θ30 + θ40+ 0,5θ50

WS0-70 cm = 0,75θ5 + 0,75θ10 +  θ20 +  θ30 + θ40+ θ50 + θ60 + 0,5θ70
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nie pomiarowym. Każdemu punktowi przyporządkowano wartość zmierzonej wil-
gotności objętościowej.

Dane zebrane podczas badań terenowych zastosowano w ocenie zróżnicowania 
przestrzennego oraz zmian czasowych uwilgotnienia gleby. Stanowiły one podstawę 
opracowania procedury oceny zasobów wodnych strefy aeracji w zlewni. Ponadto 
posłużyły do interpretacji i przeskalowania wartości zasobów wodnych strefy aera-
cji, uzyskanych z modelu HBV.

3.3.2. Koncepcja stabilności czasowej

Koncepcja stabilności czasowej została zaproponowana w pedohydrologii 
przez Vachauda i in. (1985). Zakłada ona istnienie zależności między wilgotnością 
gleby w punkcie a wartością średnią reprezentującą cały badany obszar. Podstawą 
koncepcji jest założenie, że główne czynniki kontrolujące zróżnicowanie przestrzen-
ne uwilgotnienia gleby mają charakter statyczny. Wśród nich do najważniejszych 
należy uziarnienie gleby, które zdaniem Vachauda i in. (1985) decyduje o zróżnico-
waniu uwilgotnienia gleby w małej skali. Zgodnie z tym założeniem istnieje praw-
dopodobieństwo, że jeżeli dany punkt wykazuje najwyższe uwilgotnienie w danym 
terminie pomiarowym, to będzie również najbardziej wilgotny w innym terminie, 
ponieważ decydują o tym możliwości gromadzenia wody. Nie można jednak wyeli-
minować wpływu deszczy nawalnych, które mają charakter lokalny.

Autorzy koncepcji, badając uwilgotnienie gleby, wykazali, że pewne punkty 
pomiarowe wyrażają średnie wartości dla całego badanego obszaru, podczas gdy 
inne odzwierciedlają wartości ekstremalne. Zatem czasowa stabilność może być 
rozumiana jako czasowa niezmienność pewnej struktury przestrzennego zróżnico-
wania danej zmiennej. Jednym z pierwotnych celów koncepcji było opracowanie 
metody, która pozwoliłaby zredukować liczbę punktów pomiarowych koniecznych 
do analizy dynamiki uwilgotnienia gleby na danym obszarze. Stabilność czasowa 
uwilgotnienia gleby jest przedmiotem licznych prac badawczych prowadzonych  
w różnych skalach przestrzennych i czasowych (Gómez-Plaza i in. 2000; Martínez-Fer-
nández, Ceballos 2005; Brocca i in. 2009; Jacobs i in. 2010; Somorowska, Piętka 2010).

Stabilność czasową uwilgotnienia gleby oceniono na podstawie danych wil-
gotności objętościowej, pozyskanych podczas badań terenowych. Analizę przepro-
wadzono dla warstw profili glebowych o miąższościach: 0-10, 0-30 oraz 0-50 cm. 
Ze względu na wahania zwierciadła wody w trzech profilach glebowych i brak po-
miarów na większych głębokościach w każdym terminie, stabilności czasowej nie 
oceniono dla głębszych warstw. Średnia wilgotność objętościowa w badanych war-
stwach została obliczona wg następujących równań:



gdzie: θ0-10 cm, θ0-30 cm, θ0-50 cm, – średnia wilgotność objętościowa w warstwie profilu 
podanej w indeksie dolnym [%]; θ5, θ10, θ20, θ30, θ40, θ50 – wilgotność objętościowa 
zmierzona na głębokości podanej w cm w indeksie dolnym [%].

Ocenę stabilności czasowej poprzedziła analiza zróżnicowania przestrzennego 
uwilgotnienia gleby. W tym celu wyznaczono średnią wilgotność obszarową jako 
średnią arytmetyczną z wszystkich profili w terminie pomiarowym t w warstwie  
m, a także odchylenie standardowe dla trzech warstw wg równań:

gdzie: θi,t,m – wilgotność objętościowa w profilu pomiarowym i w terminie pomiaro-
wym t w warstwie m [%], θt,m – średnia wilgotność obszarowa w terminie pomiarowym 
t w warstwie m [%], σ(θt,m) – odchylenie standardowe wilgotności w terminie pomia-
rowym t w warstwie m [%], Np – liczba profili pomiarowych [-].

Zgodnie z metodą opisaną przez Vachauda i in. (1985) analiza stabilności cza-
sowej uwilgotnienia gleby w profilach pomiarowych oraz wyznaczenie najbardziej 
reprezentatywnego profilu polega na obliczeniu wartości średniej oraz odchylenia 
standardowego wilgotności względnej. Wilgotność względna określona jest jako 
różnica między wilgotnością gleby w punkcie a wilgotnością obszarową, odniesioną 
do wilgotności obszarowej, co można wyrazić wzorem:

gdzie: δi,t,m – wilgotność względna w profilu pomiarowym i w terminie pomiarowym 
t w warstwie m [-].

Następnie dla każdego profilu wyznaczono średnią oraz odchylenie standardo-
we wilgotności względnej:

Materiał badawczy i metody badań48

θ0-10 cm = 0,75θ5 + 0,25θ10

θ0-30 cm = 0,25θ5 + 0,25θ10 + 0,333θ20 + 0,167θ30

θ0-50 cm = 0,15θ5 + 0,15θ10 + 0,2θ20 + 0,2θ30 + 0,2θ40 + 0,1θ50

(3.15)

(3.16)

(3.17)

(3.18)

(3.19)

(3.20)

(3.21)

θt,m =  θi,t,m  1 Np

i =1
∑Np

1
Np – 1

σ(θt,m) =  θt,m)2 (θi,t,m –∑
Np

i =1

θt,m
δi,t,m =  θt,mθi,t,m – 

δi,m =  δi,t,m  1 Nt

t =1
∑Nt



gdzie: δi,m – średnia wilgotność względna w profilu pomiarowym i w warstwie m [-], 
σ(δi,m) – odchylenie standardowe wilgotności względnej w profilu pomiarowym  
i w warstwie m [-], Nt – liczba terminów pomiarowych [-].

Na podstawie średniej wilgotności względnej można zidentyfikować profile 
pomiarowe, które systematycznie reprezentują warunki wilgotności zbliżone do 
średniej obszarowej bądź niższe lub wyższe od niej. Profile ze średnią wilgotno-
ścią względną bliską zeru mają uwilgotnienie bliskie średniej dla badanego obszaru. 
Wartości większe od zera są charakterystyczne dla profili wykazujących uwilgotnie-
nie większe od średniej obszarowej, a mniejsze od zera dla profili o małej wilgotno-
ści. Brak profilu pomiarowego, dla którego wartość wilgotności względnej jest bli-
ska zeru, oznacza, że żaden z profili nie reprezentuje dość dobrze wartości średniej 
obszarowej. Uwzględniając wówczas profil (określony poniżej symbolem k), dla 
którego obliczona wartość wilgotności względnej była najbliższa zeru, średnie ob-
szarowe uwilgotnienie na podstawie uwilgotnienia w tym profilu można obliczyć 
zgodnie z równaniem (Grayson, Western 1998):

gdzie: θt,m – średnia wilgotność obszarowa w terminie pomiarowym t w warstwie 
m [%], θk,t,m – wilgotność objętościowa gleby w profilu pomiarowym k w terminie 
pomiarowym t w warstwie m [%], δk,m – średnia wilgotność względna w profilu po-
miarowym k w warstwie m [%].

Wartości odchylenia standardowego wilgotności względnej wskazują na roz-
bieżności między zmiennością w czasie uwilgotnienia w danym profilu a zmienno-
ścią średniego uwilgotnienia danego obszaru. Profile pomiarowe, dla których war-
tości odchylenia standardowego są bliskie zeru charakteryzują się dużą stabilnością 
czasową uwilgotnienia. Zatem czasowa dynamika wilgotności w tych profilach jest 
zbliżona do dynamiki wilgotności obszarowej. W zależności od wartości średniej 
wilgotności względnej reprezentują one czasową zmienność średniego uwilgotnie-
nia, zaniżonego lub zawyżonego. Podsumowując, profil najlepiej reprezentujący 
zmienność czasową uwilgotnienia badanego obszaru wyróżnia się średnią warto-
ścią wilgotności względnej zbliżoną do zera oraz niewielką wartością odchylenia 
standardowego.

Metody badawcze 49

1 + δk,m
θt,m = 

θk,t,m

(3.22)

(3.23)

1
Nt – 1

σ(δi,m) =  δi,m)2 (δi,t,m –∑
Nt

t =1



3.3.3. Metoda oceny zasobów wodnych strefy aeracji w zlewni

Przyjmując założenia koncepcji stabilności czasowej o niezmienności w czasie 
przestrzennej struktury uwilgotnienia gleby, opracowano procedurę oceny zasobów 
wodnych strefy aeracji w zlewni. Uwzględniono punktową informację o uwilgot-
nieniu gleby, a także zróżnicowanie przestrzenne czynników kształtujących stan 
retencji. Wybrano trzy czynniki: topografię, uziarnienie oraz roślinność. W anali-
zie nie uwzględniono położenia zwierciadła wody podziemnej, które również wpły-
wa na warunki wilgotnościowe strefy aeracji. Było to spowodowane trudnościami  
w parametryzacji tego czynnika, wynikającymi przede wszystkim z braku dokład-
nych danych. Jednak zakładając, że położenie pierwszego swobodnego zwierciadła 
wody podziemnej jest kontrolowane przez ukształtowanie powierzchni terenu, czyn-
nik ten pośrednio ujęto podczas parametryzacji topografii.

Opracowaną procedurę zrealizowano w dwóch etapach. W pierwszym obliczo-
no przestrzennie zróżnicowany topograficzny wskaźnik wilgotności TWI w czterech 
wersjach:

•	 TWI w wersji klasycznej,
•	 TWI z uwzględnieniem wpływu uziarnienia (modyfikacja 1),
•	 TWI z uwzględnieniem wpływu roślinności (modyfikacja 2),
•	 TWI z uwzględnieniem wpływu uziarnienia i roślinności (modyfikacja 3).

Spośród czterech wersji, w drugim etapie, wybrano jeden wskaźnik, który 
uznano za statyczny model struktury przestrzennej warunków wilgotnościowych  
w zlewni. Integrując mapę wybranego wskaźnika z wynikami badań terenowych, 
obliczono średnie uwilgotnienie gleby w zlewni, a następnie przeliczono je na war-
tość zapasu wody.

Topograficzny wskaźnik wilgotności TWI
Topograficzny wskaźnik wilgotności TWI został wprowadzony przez Bevena 

i Kirkby’ego (1979) wraz z modelem hydrologicznym TOPMODEL. Jest to mate-
matyczna parametryzacja stanu uwilgotnienia gleby wyrażona funkcją nachylenia 
stoku i powierzchni obszaru zasilającego daną komórkę. Wskaźnik TWI obliczany 
jest za pomocą równania:

gdzie: TWI – topograficzny wskaźnik wilgotności [-], As – powierzchnia obszaru za-
silającego daną komórkę podzielona przez bok komórki [m2·m-1], β – kąt nachylenia 
stoku [rad].
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TWI = ln As
tanβ (3.24)



Wskaźnik TWI opisuje wpływ topografii na kształtowanie się uwilgotnienia 
gleby. Pozwala on na oszacowanie tendencji do gromadzenia wody opadowej lub 
roztopowej w danym punkcie zlewni (Quinn i in. 1991). Zgodnie z powyższym wy-
rażeniem, im większy obszar zasilania i mniejszy kąt nachylenia stoku, tym większy 
jest wskaźnik TWI, czyli większe uwilgotnienie. Zatem, uwzględniając topografię, 
obszarami predysponowanymi do gromadzenia wody w glebie są obszary płaskie 
o dużym obszarze zasilania. Zakłada się, że obszary zlewni o tej samej wartości 
wskaźnika TWI podobnie reagują na opad deszczu, pod warunkiem, że charakte-
ryzują się zbliżonymi cechami środowiska, takimi jak m.in. typ gleby (Qin i in. 
2011). Wartości wskaźnika TWI są liczbami niemianowanymi i nie mają wymiaru 
wielkości fizycznych. W literaturze wskaźnik TWI funkcjonuje również pod nazwą 
Compound Topographic Index (Gessler i in. 1995; Yang i in. 2005).

Wskaźnik TWI jest szeroko stosowany w literaturze do oceny zróżnicowania 
przestrzennego warunków wilgotnościowych (m.in. Western i in. 1999; Lin i in. 
2006a; Temimi i in. 2010). Grabs i in. (2009) wykorzystali wskaźnik do identyfi-
kacji mokradeł w zlewni. Topografia steruje bowiem spływem powierzchniowym 
i podpowierzchniowym wody oraz wpływa na procesy jej retencji. Z tego powodu 
wskaźnik TWI był również wykorzystywany w analizach zróżnicowania przestrzen-
nego innych właściwości gleby, m.in. zawartości mniejszych frakcji i materii orga-
nicznej oraz pH i głębokości profilu (Moore i in. 1993; Seibert i in. 2007). Zinko  
i in. (2005) badali związek wartości wskaźnika TWI z liczebnością poszczególnych 
gatunków roślin. Istnieją również prace przedstawiające zagadnienia dotyczące me-
todyki obliczania wskaźnika i wpływu zastosowanych algorytmów na uzyskiwane 
wyniki (Quinn i in. 1995; Sørensen i in. 2006; Sørensen, Seibert 2007). W polskiej 
literaturze Giętkowski i Zachwatowicz (2008) zastosowali wskaźnik TWI w opraco-
waniu klasyfikacji typów morfometrycznych rzeźby terenu.

Wskaźnik TWI zaliczany jest do wtórnych atrybutów topograficznych (Urbań-
ski 2008), które w przeciwieństwie do pierwotnych atrybutów nie są obliczane bez-
pośrednio z danych numerycznego modelu terenu. Powstają poprzez wykorzystanie 
atrybutów pierwotnych i mogą być stosowane do opisu procesów wykazujących 
zróżnicowanie przestrzenne zależne od topografii. Na wartość uzyskanego wskaźni-
ka mają wpływ rozdzielczość przestrzenna numerycznego modelu terenu oraz wy-
bór algorytmu do obliczenia kierunku spływu wody w zlewni, na podstawie którego 
oblicza się następnie wartość parametru As (Schmidt, Persson 2003).

Mapę wskaźnika TWI dla zlewni Liwca wykonano na podstawie numerycz-
nego modelu terenu SRTM, opisanego w rozdz. 3.2.4 i przedstawionego na rys. 3.2  
w rozdz. 3.1. Mapę opracowano w programie ArcGIS 10.0. Etapy powstawania mapy 
oraz procedury programu, które w nich zastosowano, przedstawiono na rys. 3.11.
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W pierwszym etapie przetwarzaniu poddano numeryczny model terenu. Usu-
nięto z niego zagłębienia terenu, które przyczyniają się do wadliwego modelowania 
spływu wody po terenie, o czym pisali m.in. O’Callaghan i Mark (1984), Beven 
(1997), Qin i in. (2011). Zagłębienia takie powstają w procesie opracowywania nu-
merycznego modelu terenu (Urbański 2008; Wu i in. 2008). Do usunięcia nieprawi-
dłowych zagłębień zastosowano procedurę Fill Sinks (ArcHydro Tools → Terrain 
Preprocessing). Powoduje ona „wygładzenie” zagłębień poprzez przypisanie im 
najmniejszej wartości wysokości z sąsiadujących pikseli. Tak przygotowany nume-
ryczny model terenu charakteryzował się zakresem wysokości w zlewni Liwca od 
86 m n.p.m. do 222 m n.p.m., przy najczęściej występującej wartości komórki rastra 
równej 160 m n.p.m.

Na podstawie numerycznego modelu terenu wykonano mapę spadków. W tym 
celu zastosowano narzędzie Slope (Spatial Analyst Tools → Surface). Mapę spad-
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Rys. 3.11. Schemat opracowania mapy TWI w programie ArcGIS 10.0



ków przedstawia rys. 3.12. W zlewni Liwca wartości nachylenia wahają się od 0° 
do 8,89°. Obecność obszarów idealnie płaskich o wartości komórek rastra równej 
zeru implikuje obecność błędów w dalszej analizie. Zgodnie z równaniem 3.24,  
w przypadku gdy kąt nachylenia β równy jest zeru, wartość wskaźnika TWI jest nie-
określona. Na problem obszarów płaskich w modelowaniu hydrologicznym z wy-
korzystaniem numerycznego modelu terenu między innymi w kontekście określa-
nia kierunków spływu zwracało uwagę wielu autorów, wśród nich Tarboton (1997) 
oraz Grabs i in. (2009). W niniejszej pracy problem ten rozwiązano przez wyeli-
minowanie z mapy spadków komórek rastra o wartości 0 i zastąpienie ich warto-
ścią 0,01. Stanowiły one jedynie 3,7% powierzchni zlewni Liwca. Podobną metodę 
zastąpienia obszarów płaskich obszarami o nieznacznym nachyleniu zaimplemen-
towali Planchon i Darboux (2001). Zamiany wartości komórek rastra, w których 
zakodowany jest spadek, dokonano za pomocą narzędzia Raster Calculator (Spatial 
Analyst Tools → Map Algebra) z zastosowaniem wyrażenia con(”slope”==0, 0.01, 
”slope”). Ostatnim etapem w przetwarzaniu mapy spadków było obliczenie tangen-
sa kąta nachylenia. Wymagało to wyrażenia kąta w radianach. Zamiany jednostek 
dokonano za pomocą procedury Raster Calculator (Spatial Analyst Tools → Map 
Algebra) przez podzielenie wartości komórek rastra z mapy spadków wyrażonych  
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Rys. 3.12. Spadki terenu w zlewni Liwca na podstawie danych SRTM



w stopniach przez wartość 57,296. Obliczenia funkcji trygonometrycznych dokonano 
również za pomocą narzędzia Raster Calculator.

Kolejnym krokiem było opracowanie mapy kierunków spływu za pomocą pro-
cedury Flow Direction (Spatial Analyst Tools → Hydrology). Kierunek spływu zo-
stał obliczony metodą D8, która zakłada, że woda z danej komórki może spływać 
tylko do jednej z ośmiu sąsiadujących komórek (O’Callaghan, Mark 1984). Ruch 
wody odbywa się zgodnie z nachyleniem terenu. Efektem końcowym jest mapa, na 
której każdemu pikselowi przyporządkowany jest jeden z ośmiu kierunków podsta-
wowych: N, NE, E, SE, S, SW, W, NW, zakodowanych za pomocą wartości liczbo-
wych, zgodnie z legendą na rys. 3.13.

Mapa kierunków spływu stanowiła podstawę do opracowania mapy akumulacji 
spływu za pomocą procedury Flow accumulation (Spatial Analyst Tools → Hydrology). 
Wartość komórki rastra na mapie akumulacji spływu odpowiada liczbie komórek, z któ-
rych następuje do niej spływ wody. Przyjmując pewną wartość progową, odpowiadają-
cą ilości wody przepływającej przez daną komórkę, można wyznaczyć na mapie cieki 
stałe (Urbański 2008). Schemat powstawania mapy akumulacji spływu przedstawiono 
na rys. 3.14. Z kolei rys. 3.15 przedstawia mapę akumulacji spływu zlewni Liwca.

Rys. 3.13. Kierunki powierzchniowego spływu wody w zlewni Liwca na podstawie danych SRTM
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Mapa akumulacji spływu zawiera wartości równe zeru, co powoduje analogicz-
ny problem, jak w przypadku mapy spadków. Zostały one wyeliminowane poprzez 
dodanie wartości 1 do każdej komórki rastra. Następnie, aby uzyskać wartość para-
metru As, występującego w liczniku równania 3.24, wartość każdej komórki rastra 
została pomnożona przez jej powierzchnię i podzielona przez długość boku, zgodnie 
z równaniem:

Rys. 3.15. Akumulacja spływu w zlewni Liwca na podstawie danych SRTM

Rys. 3.14. Etapy powstawania mapy kierunku spływu oraz mapy akumulacji spływu: 
(a) – numeryczny model terenu, (b) – kodowana mapa kierunków spływu (wg legendy z rys. 3.13), 

(c) – mapa kierunków spływu, (d) – mapa akumulacji spływu (Urbański 2008)
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As  = n  · b2

b (3.25)



gdzie: n – liczba komórek, z których następuje spływ wody [-], b – długość boku 
komórki [m].

Na podstawie mapy spadków oraz mapy akumulacji spływu, stosując równanie 
3.24, wykonano mapę wskaźnika TWI dla zlewni Liwca za pomocą narzędzia Ra-
ster Calculator (Spatial Analyst Tools → Map Algebra). Mapa TWI w rozdzielczo-
ści 76,2×76,2 m została następnie zgeneralizowana do rozdzielczości 150×150 m.  
W pierwszym kroku zastosowano narzędzie Aggregate (Spatial Analyst Tools → 
Generalization). Wielkości komórek rastra zwiększono dwukrotnie, a ich nowe war-
tości zostały obliczone jako średnia arytmetyczna z wartości początkowych. Następ-
nie za pomocą procedury Resample (Data Management Tools → Raster → Raster 
Processing) dostosowano wielkość komórki rastra do rozdzielczości 150×150 m.

Topograficzny wskaźnik wilgotności uwzględniający wpływ uziarnienia TWImod1

Pierwsza modyfikacja TWI polegała na opracowaniu wskaźnika, który 
uwzględniałby zarówno wpływ topografii, jak i zróżnicowanie możliwości reten-
cyjnych utworów budujących strefę aeracji. Wymagało to dokonania parametryzacji 
uziarnienia gleb. Nowy wskaźnik oznaczono indeksem „mod1”. Schemat powsta-
wania mapy TWImod1 przedstawia rys. 3.16. Analizę wykonano dla warstwy gleby  
o miąższości 0-50 cm.

Podstawę w analizie zróżnicowania przestrzennego gatunków gleb stanowiła 
cyfrowa mapa glebowo-rolnicza w skali 1:25 000, której treść dodatkowo dla ob-
szarów lasów została uzupełniona z leśnej mapy numerycznej. Charakterystykę 
map zamieszczono w rozdz. 3.2.4. Na obu mapach gatunek gleby przedstawiono 
jako podgrupy granulometryczne określone zgodnie ze starą klasyfikacją utworów 
mineralnych Polskiego Towarzystwa Gleboznawczego (PTG 1956). Podjęte próby 
przełożenia map wg aktualnie stosowanego podziału PTG (2009) wskazywały na 
znaczne rozbieżności w obu podziałach. Różnice dotyczą zarówno podziału wielko-
ści ziaren na frakcje i podfrakcje granulometryczne, jak i podziału na grupy i pod-
grupy granulometryczne. Nie dysponując danymi źródłowymi ze szczegółowych la-
boratoryjnych badań uziarnienia, na podstawie których określono grupy i podgrupy 
granulometryczne przedstawione na mapach glebowo-rolniczych i glebowo-siedli-
skowych, poprawne przełożenie klasyfikacji było niemożliwe. Z tego powodu w dal-
szej analizie zastosowano oryginalne materiały kartograficzne. Ułatwiło to również 
ocenę możliwości retencyjnych poszczególnych podgrup granulometrycznych, wg 
wartości polowej pojemności wodnej, wykonaną na podstawie literatury.

W pierwszym etapie wektorową mapę podgrup granulometrycznych poddano 
rasteryzacji za pomocą procedury Polygon to Raster (Conversion Tools → To Ra-
ster). W trakcie rasteryzacji mapę dopasowano do mapy klasycznego wskaźnika TWI, 
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uzyskując zgodność obu map pod względem rozmiaru komórek rastra oraz współ-
rzędnych ich położenia. Opracowana mapa rastrowa zawierała wartości komórek  
w zakresie od 1 do 15. Pełniły one funkcję identyfikatorów w tablicy atrybutowej,  
w której znajdowały się wartości komórek rastra oraz przyporządkowane im symbole 
podgrup granulometrycznych. Obszarom pozbawionym danych, oznaczonym iden-
tyfikatorem 15, przypisano wartość NoData i wykluczono z dalszej analizy. Zajmują 
one niewiele ponad 0,5% powierzchni zlewni i stanowią je w większości zbiorniki 
wodne. Dokonano tego za pomocą wyrażenia SetNull (”uziarnienie”==15, ”uziar-
nienie”) w Raster Calculator (Spatial Analyst Tools → Map Algebra).

Rastrową mapę podgrup granulometrycznych osadów w warstwie 0-50 cm 
przedstawia rys. 3.17. W tabl. 3.5 zestawiono procentowy udział powierzchni po-
szczególnych podgrup granulometrycznych, obliczony na podstawie danych wek-
torowych i rastrowych. Zauważono niewielkie różnice w obliczonych wartościach, 
sięgające maksymalnie 0,14% w przypadku piasku słabogliniastego. Zgodnie z da-
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Rys. 3.16. Schemat opracowania mapy TWImod1 w programie ArcGIS 10.0



nymi rastrowymi, zastosowanymi w dalszej analizie, w warstwie do 50 cm występu-
ją głównie piaski. Zajmują one 87,62% całkowitej powierzchni zlewni Liwca oraz 
ok. 86,49% zlewni po profil wodowskazowy w Łochowie. Wśród nich przeważają 
piaski luźne, słabogliniaste i gliniaste lekkie. Pyły stanowią 4,37% zlewni całkowitej 
oraz 4,79% zlewni po profil w Łochowie, a ich występowanie ograniczone jest do 
południowo-wschodniej części zlewni. Utwory zaliczone do glin występują przede 
wszystkim w części środkowej. Zajmują powierzchnię 3,87% całej zlewni i 4,16% 
zlewni po profil w Łochowie. Torfy zajmują 3,57% powierzchni całkowitej zlewni 
oraz 3,95% zlewni po profil w Łochowie. Występują one przede wszystkim w połu-
dniowej części zlewni w dolinach rzek.

Kolejnym etapem było przeprowadzenie parametryzacji osadów, ze względu 
na ich właściwości retencyjne. Jej celem było ustalenie wartości współczynników 
dla poszczególnych podgrup granulometrycznych, występujących w zlewni Liwca, 
które następnie zostały zastosowane w obliczeniach TWImod1. Założono, że współ-
czynniki powinny obrazować różnice w możliwościach retencyjnych pomiędzy pod-
grupami. Przyjęty współczynnik określałby, o ile utwór z danej podgrupy może być 
wilgotniejszy bądź suchszy od innego, przy zbliżonych warunkach topograficznych, 
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Rys. 3.17. Litologia osadów powierzchniowych w warstwie 0-50 cm w postaci danych rastrowych 
(objaśnienia symboli znajdują się w tabl. 3.5)
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roślinnych i meteorologicznych. W praktyce jest to zadanie niezwykle trudne ze 
względu na mnogość czynników mogących decydować o zdolnościach retencyjnych 
gleb oraz ograniczoną ilość dostępnych danych empirycznych. Przyjmując pewne 
uproszczenia, wartości współczynników zostały określone za pomocą różnic w po-
lowej pojemności wodnej podgrup granulometrycznych, określonych na podstawie 
danych zebranych z literatury oraz na podstawie analizy własnych pomiarów tere-
nowych. Przyjęte współczynniki nazwano względnymi współczynnikami uwilgot-
nienia (WWU).

Polowa pojemność wodna jest statyczną charakterystyką gleby, która określa 
maksymalną ilość wody, jaka może być utrzymana w glebie po odcieknięciu wody 
grawitacyjnej. Woda wiązana jest wówczas w glebie siłami ssania o wartości pF ≈ 
2. Wartość polowej pojemności wodnej różnicowana jest przede wszystkim przez 
skład granulometryczny (Walczak i in. 2002). Z tego powodu może być stosowana 
jako miara wielkości retencji utworów powierzchniowych. 

Obszerną bazę charakterystycznych wartości pF dla typów mineralnych gleb 
ornych, na podstawie 290 zbadanych profili glebowych, opracowali Walczak i in. 

Tablica 3.5
Udział poszczególnych podgrup granulometrycznych 
w zlewni Liwca wg danych wektorowych i rastrowych

Podgrupa granulometryczna Symbol
Udział w całkowitej powierzchni 

zlewni Liwca [%]
Udział w powierzchni zlewni 

Liwca po profil w Łochowie [%]
wektor raster wektor raster

żwir piaszczysty zp 0,04 0,04 0,05 0,04

piasek luźny pl 20,76 20,69 19,67 19,57

piasek słabogliniasty ps 27,12 27,20 25,85 25,99

piasek słabogliniasty pylasty psp 0,85 0,86 0,90 0,92

piasek gliniasty lekki pgl 23,41 23,52 23,99 23,96

piasek gliniasty lekki pylasty pglp 4,58 4,58 4,88 4,93

piasek gliniasty mocny pgm 9,10 9,08 9,32 9,24

piasek gliniasty mocny pylasty pgmp 1,72 1,69 1,88 1,88

pył zwykły plz 4,32 4,31 4,69 4,73

pył ilasty pli 0,05 0,06 0,06 0,06

glina lekka gl 2,91 2,89 3,13 3,12

glina lekka pylasta glp 0,48 0,49 0,49 0,50

glina średnia gs 0,50 0,49 0,56 0,54

torf t 3,60 3,57 3,96 3,95

brak danych - 0,56 0,53 0,57 0,57



(2002). Jak wynika z tych badań, wielkość retencji wodnej przy pF = 2,2 waha się  
w granicach od 3,9% wilgotności objętościowej w podglebiu gleb brunatnych i pseu-
dobielicowych wytworzonych ze żwirów do 45,5% w warstwie podornej gleb bru-
natnych i pseudobielicowych wytworzonych z iłów. Badania te obrazują możliwy 
zakres wielkości retencji przy pF = 2,2 mineralnych utworów glebowych w Polsce. 
Jednak nie przedstawiają bezpośrednio związków pomiędzy uziarnieniem a warto-
ścią polowej pojemności wodnej.

Badania dotyczące zależności między składem granulometrycznym a za-
wartością wody przy wybranych wartościach pF mają najczęściej charakter frag-
mentaryczny i nie ujmują w sposób kompleksowy różnic między poszczególnymi 
gatunkami gleb. Ponadto ich wyniki są trudne do porównania ze względu na sto-
sowanie różnych metod i klasyfikacji. Krzywe retencji wodnej dla wybranych ga-
tunków gleb na podstawie własnych badań przedstawił Zawadzki (za Dobrzański, 
Zawadzki 1995). Natomiast Sławiński (2003) analizował skład granulometryczny 
oraz polową pojemność wodną przy pF = 2,2 w badaniach wpływu fizycznych pa-
rametrów gleby na wartość współczynnika przewodnictwa wodnego. Przeprowadził 
analizy 145 próbek glebowych. Zestawienie wartości polowej pojemności wodnej 
dla gatunków gleb wg różnych autorów na potrzeby modelowania hydrologicznego 
opracowała Gutry-Korycka (1996). W tabl. 3.6 przedstawiono wartości polowej po-
jemności wodnej dla poszczególnych podgrup granulometrycznych, występujących  
w zlewni Liwca, które zostały określone wg różnych autorów. 

Dysponując własnymi oznaczeniami laboratoryjnymi uziarnienia gleb oraz po-
miarami wilgotności objętościowej gleby, podjęto próbę określenia różnic w uwil-
gotnieniu utworów, reprezentujących różne podgrupy granulometryczne. Skupiono 
się na różnicach pomiędzy uwilgotnieniem piasku luźnego, piasku słabogliniastego 
oraz piasku gliniastego lekkiego, ponieważ ich udział w powierzchni zlewni po pro-
fil w Łochowie jest największy. Razem utwory te zajmują ok. 70% powierzchni.  
W analizie uwzględniono jedynie profile Sinołęka, Świniary i Grochów. Reprezentu-
ją one zbliżone położenie topograficzne, pokrycie roślinnością, a ponadto nie obser-
wowano w tych profilach wahań zwierciadła wody podziemnej, które może bezpo-
średnio wpływać na wilgotność profilu. Zakładając zbliżone warunki topograficzne 
tych trzech profili przyjęto, że głównym czynnikiem decydującym o różnicach w ich 
uwilgotnieniu jest uziarnienie.

Do porównania uwilgotnienia piasku luźnego i słabogliniastego oraz piasku 
luźnego i gliniastego lekkiego wybrano odpowiednio warstwę 20-40 cm w profilach 
Sinołęka i Grochów oraz warstwę 40-60 cm w profilach Sinołęka i Świniary. Obie te 
warstwy w profilu Sinołęka tworzy piasek luźny. Profil Grochów w warstwie 20-40 
cm zbudowany jest z piasku słabogliniastego. Z kolei profil Świniary w warstwie 
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40-60 cm zbudowany jest z piasku gliniastego lekkiego. Wilgotność objętościową 
dla warstw 20-40 cm oraz 40-60 cm obliczono zgodnie z równaniami:

gdzie: θ20-40 cm, θ40-60 cm – średnia wilgotność objętościowa w warstwach profilu po-
danych w indeksach dolnych [%], θ20, θ30, θ40, θ50, θ60 – wilgotność objętościowa na 
głębokościach podanych w indeksach dolnych w cm [%].

Tablica 3.7 przedstawia wartości minimalne, maksymalne i średnie określone 
dla opisanych warstw profili ze wszystkich terminów pomiarowych oraz relacje wil-
gotności pomiędzy utworami budującymi te warstwy. Z analizy wynika, że piasek 
słabogliniasty był w okresie badań terenowych średnio ok. 1,6 raza wilgotniejszy niż 
piasek luźny, a wartość maksymalnego uwilgotnienia była 2 razy większa. Należy 
jednak zauważyć, że piasek słabogliniasty w profilu Grochów charakteryzuje się 
niską zawartością części spławialnych (6%), a jego właściwości retencyjne są bar-
dziej zbliżone do właściwości piasku luźnego niż piasku gliniastego lekkiego. Zatem 

Tablica 3.6
Wartości polowej pojemności wodnej wg różnych autorów

Podgrupa granulometryczna

Polowa pojemność wodna [%]

wg Zawadzkiego 
(Dobrzański, Zawadzki 1995)

pF = 2,5

wg Sławińskiego 
(2003)
pF = 2,2

wg różnych autorów
(Gutry-Korycka 1996)

pF = 2,5

żwir piaszczysty - - 11

piasek luźny 4 5-15 12

piasek słabogliniasty 12 8-22 14

piasek słabogliniasty pylasty - - -

piasek gliniasty lekki 20 12-26 24

piasek gliniasty lekki pylasty - - -

piasek gliniasty mocny 21 17-25 28

piasek gliniasty mocny pylasty - - -

pył zwykły 32 16-39 28

pył ilasty 27 29-39 -

glina lekka 25 20-33 32

glina lekka pylasta - 21-43 38

glina średnia 27 22-56 27

torf - - 40

θ20-40 cm = 0,25θ20 + 0,5θ30 + 0,25θ40

θ40-60 cm = 0,25θ40 + 0,5θ50 + 0,25θ60

(3.26)

(3.27)



obliczone proporcje mogą być nieznacznie zaniżone. Z kolei piasek gliniasty lekki 
jest średnio ok. 3 razy wilgotniejszy niż piasek luźny, przy założeniu braku wpływu 
innych czynników. Przeprowadzona analiza ma charakter jedynie szacunkowy.

Na podstawie danych literaturowych i analizy własnych badań terenowych 
dla każdej podgrupy granulometrycznej, występującej w zlewni Liwca, określono 
względne współczynniki uwilgotnienia (WWU), przedstawione w tabl. 3.8. Wartość 
współczynnika WWU dla piasku luźnego przyjęto jako 1, a następnie odniesiono 
do niego wartości współczynników dla pozostałych utworów. Współczynniki WWU 
ustalono w zakresie od 1 do 4,5, z wielkością przedziału równą 0,5.

Na podstawie mapy podgrup granulometrycznych w warstwie 0-50 cm wyko-
nano mapę współczynników WWU przez zastosowanie procedury Reclassify (Spa-
tial Analyst Tools → Reclass). Polegała ona na przyporządkowaniu poszczególnym 
komórkom rastra nowych wartości zgodnie z tabl. 3.8. Wartości komórek rastra  
z zakresu od 1 do 14 zamieniono na wartości współczynników. Rysunek 3.18 przed-
stawia mapę współczynników WWU.

Ostatnim krokiem było pomnożenie wartości komórek rastra mapy klasycznego 
wskaźnika TWI przez komórki rastra mapy współczynników WWU za pomocą na-
rzędzia Raster Calculator (Spatial Analyst Tools → Map Algebra). W ten sposób po-

Materiał badawczy i metody badań62

Rys. 3.18. Współczynniki WWU zastosowane przy opracowywaniu mapy TWImod1



wstała mapa wskaźnika TWImod1, który uwzględniając wpływ topografii oraz zdolności 
retencyjne utworów, ukazuje potencjalne uwilgotnienie gleby w warstwie 0-50 cm.
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Tablica 3.7
Minimalna, maksymalna i średnia wilgotność objętościowa w wybranych warstwach 

profili Sinołęka, Świniary i Grochów oraz relacje wilgotności pomiędzy profilami

(a)
Profil Sinołęka Grochów

Relacja wilgotności 
ps do plWarstwa [cm] 20-40 20-40

Grupa granulometryczna piasek luźny (pl) piasek słabogliniasty (ps)
Wilgotność objętościowa [%]:
- minimalna
- maksymalna
- średnia

4,6
10,6
7,6

9,0
15,1
12,1

2,0
1,4
1,6

(b)
Profil Sinołęka Świniary

Relacja wilgotności 
pgl do plWarstwa [cm] 40-60 40-60

Grupa granulometryczna piasek luźny (pl) piasek gliniasty lekki (pgl)
Wilgotność objętościowa [%]:
- minimalna
- maksymalna
- średnia

4,2
8,8
6,7

11,0
25,9
20,2

2,6
2,9
3,0

Tablica 3.8
Wartości względnych współczynników uwilgotnienia (WWU) 

przyporządkowane podgrupom granulometrycznym

Podgrupa granulometryczna Wartość komórki rastra mapy 
podgrup granulometrycznych Współczynnik WWU

żwir piaszczysty 1 1

piasek luźny 2 1

piasek słabogliniasty 3 2

piasek słabogliniasty pylasty 4 2,5

piasek gliniasty lekki 5 3

piasek gliniasty lekki pylasty 6 3,5

piasek gliniasty mocny 7 3

piasek gliniasty mocny pylasty 8 3,5

pył zwykły 9 3,5

pył ilasty 10 3,5

glina lekka 11 3,5

glina lekka pylasta 12 4

glina średnia 13 4

torf 14 4,5



Topograficzny wskaźnik wilgotności uwzględniający wpływ roślinności TWImod2

Druga modyfikacja wskaźnika TWI polegała na uwzględnieniu zarówno wpły-
wu topografii, jak i zróżnicowania przestrzennego roślinności. W tym celu zastoso-
wano metodę zaproponowaną przez Temimi’ego i in. (2010), wg której klasyczny 
wskaźnik TWI został przekształcony do następującej postaci:

gdzie: As – powierzchnia obszaru zasilającego daną komórkę podzielona przez bok 
komórki [m2·m-1], β – kąt nachylenia stoku [rad].

Symbol V odpowiada stopniowi pokrycia roślinnością i jest szacowany na pod-
stawie równania zaproponowanego przez Eaglesona (1982):

gdzie: μ – parametr opisujący gęstość roślinności [-], LAI – współczynnik powierzch-
ni liścia [m2·m-2].

Ostatecznie zmodyfikowany wskaźnik wilgotności, oznaczony indeksem 
„mod 2”, obliczono za pomocą równania:

Wartość parametru μ przyjęto w uproszczeniu jako stałą dla całego badanego 
obszaru. Charakteryzuje on średnią gęstość roślinności i waha się w zakresie od 
0,35 dla roślinności trawiastej i 0,40 dla upraw do ok. 0,50-0,77 dla lasów (Eagleson 
1982). Mapę wskaźnika TWImod2 opracowano zgodnie z równaniem 3.30 w kolejnych 
etapach, przedstawionych na rys. 3.19.

Przestrzenne zróżnicowanie roślinności w równaniu 3.30 zostało uwzględnione 
w postaci wskaźnika LAI, który nazywany jest współczynnikiem powierzchni liścia 
bądź powierzchnią projekcyjną liścia. Wskaźnik LAI określa sumę powierzchni liści 
przypadającą na powierzchnię terenu. Przyjmuje on wartości od ok. 2-4 dla upraw 
zbożowych do ok. 6-8 dla lasów. Przy obliczaniu wskaźnika TWImod2 zastosowano 
mapy wskaźnika LAI pozyskane z projektu MODIS. Wykorzystano produkt o na-
zwie MOD15A2 w rozdzielczości przestrzennej 1 km.

Mapy LAI zostały przetworzone w programie ArcGIS 10.0. Na początku wy-
konano ich przepróbkowanie w celu dostosowania wielkości komórek rastra mapy 
LAI do wielkości komórek rastra NMT. W tym celu wykorzystano procedurę Re-
sample (Data Management Tools → Raster → Raster Processing). Następnie ko-
mórki rastra o wartości 250, oznaczające obszary zurbanizowane, zostały zastąpione 
wartościami NoData i pominięte w dalszej analizie. Grupa takich komórek znajduje 

TWI = V · ln(As) + (1 – V) · ln ( )1
tanβ (3.28)

(3.29)

(3.30)

V = 1 – exp(–µ · LAI)

TWImod2 = ln(As) – ln(As · tanβ) · e–µ · LAI 
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się w południowo-wschodniej części zlewni, gdzie zlokalizowane jest miasto Siedl-
ce. Dokonano tego za pomocą wyrażenia SetNull („LAI” == 250, „LAI”) w Raster 
Calculator (Spatial Analyst Tools → Map Algebra). Biofizyczną wartość wskaźnika 
LAI w komórkach rastra uzyskano, zgodnie z instrukcją dla użytkowników danych, 
mnożąc pierwotne wartości pikseli przez współczynnik skali 0,1 (Myneni i in. 2003). 
W ten sam sposób przetworzono 23 mapy wskaźnika LAI, pochodzące z okresu od 
maja do października 2010 r. 

Rysunek 3.20 przedstawia rozkład przestrzenny wskaźnika LAI w przykła-
dowych sześciu terminach, po jednym z każdego miesiąca. Najmniejsze wartości 
wskaźnika LAI w zakresie od 0,3 do 4,7, przy średniej 0,89, zaobserwowano w paź-
dzierniku. We wszystkich pozostałych terminach największa wartość przekraczała 
6,0. Największe wartości (z zakresu od 0,8 do 6,8, przy średniej 2,63) wskaźnik 
osiągnął w czerwcu, kiedy rośliny znajdują się w pełnej fazie rozwoju.

Rys. 3.19. Schemat opracowania mapy TWImod2 w programie ArcGIS 10.0
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Następnie obliczono średnią wartość wskaźnika LAI dla okresu od maja do 
października na podstawie 23 map za pomocą narzędzia Raster Calculator (Spatial 
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Rys. 3.20. Wskaźnik LAI w zlewni Liwca w sześciu przykładowych terminach w okresie 
od maja do października 2010 r.: (a) 17.05.2010, (b) 02.06.2010, (c) 04.07.2010, 

(d) 05.08.2010, (e) 06.09.2010, (f) 08.10.2010
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Analyst Tools → Map Algebra). W ten sposób powstała mapa obrazująca średnią 
wartość LAI w zlewni w okresie od maja do października, która była wykorzystywa-
na w dalszych obliczeniach. Mapę tę przedstawia rys. 3.21. Wartość wskaźnika LAI 
w zlewni Liwca waha się od 0,6 do 5,3, przy średniej wartości 1,4.

Na podstawie równania 3.30 obliczono wartości wskaźnika TWImod2 (Spatial 
Analyst Tools → Map Algebra Raster → Raster Calculator), zgodnie z wyrażeniem: 
ln(”As”)-ln(”As”*”tanβ”)*2.718**(-0.45*”LAI”). Wartość parametru μ przyję-
to jako równą 0,45. Mapa TWImod2, podobnie jak w przypadku mapy klasycznego 
wskaźnika, została zagregowana do rozdzielczości 150×150 m.

Topograficzny wskaźnik wilgotności uwzględniający wpływ uziarnienia i roślinności TWImod3
Trzecia modyfikacja wskaźnika TWI polegała na połączeniu dwóch poprzed-

nich modyfikacji. Mapę współczynników WWU, obrazujących różnice w retencyj-
ności gleb, która stanowiła podstawę przy opracowaniu mapy wskaźnika TWImod1, 
zintegrowano z mapą wskaźnika TWImod2, uwzględniającą zróżnicowanie roślinno-
ści. Dokonano tego za pomocą narzędzia Raster Calculator (Spatial Analyst Tools 
→ Map Algebra). Opracowany wskaźnik oznaczono indeksem „mod3”. Schemat 
powstawania mapy TWImod3 przedstawia rys. 3.22. 

Rys. 3.21. Średnia wartość wskaźnika LAI w zlewni Liwca dla okresu od maja do października 2010 r.



Wskaźnik TWImod3 obrazuje zróżnicowanie przestrzenne możliwości groma-
dzenia wody w strefie aeracji do głębokości 50 cm, uwzględniając wpływ trzech 
czynników: topografii, uziarnienia oraz roślinności. Wskazuje on na potencjalne 
zróżnicowanie uwilgotnienia gleby w analizowanej zlewni.

Ocena zasobów wodnych strefy aeracji w zlewni
Oceny zasobów wodnych strefy aeracji w zlewni dokonano na podstawie opra-

cowanych statycznych wskaźników TWI oraz danych empirycznych, ukazujących 
dynamikę czasową uwilgotnienia gleby. Wartości czterech wskaźników TWI w ko-
mórkach rastra, w obrębie których zlokalizowane są profile pomiarowe, porównano 
z rzeczywistymi wartościami średniego uwilgotnienia gleby w profilach w warstwie 
0-50 cm. Następnie wybrano jeden wskaźnik, który najlepiej obrazuje zróżnicowa-
nie uwilgotnienia profili. Oceny zasobów wodnych w zlewni na podstawie wybrane-
go wskaźnika TWI oraz na podstawie wyników badań terenowych dokonano dwoma 
metodami.

W pierwszej metodzie poddano grupowaniu wartości wskaźnika TWI. Podstawę 
stanowiły wyniki badań terenowych. Każdemu profilowi glebowemu, od najmniej 
do najbardziej wilgotnego, przyporządkowano wartości wskaźnika TWI. Granice 
przedziałów ustalono w połowie wartości między wartościami wskaźnika w komór-
kach rastra reprezentujących kolejne dwa profile glebowe. W ten sposób powstało 
sześć klas wskaźnika TWI. Analizując zróżnicowanie przestrzenne wskaźnika TWI, 
określono, które obszary zlewni charakteryzują się zbliżonymi do danego profilu 
warunkami wilgotnościowymi. Obliczono powierzchnię obszarów w każdej klasie  
i określono jej udział w zlewni. Następnie średnie uwilgotnienia gleby w zlewni ob-
liczono na podstawie wilgotności objętościowej pomierzonej w profilach jako śred-
nią ważoną. Wagi określają procent powierzchni zlewni, dla której dany profil uzna-
no za reprezentatywny. Średnie uwilgotnienie w zlewni przeliczono na zapas wody.

Rys. 3.22. Schemat opracowania mapy TWImod3 w programie ArcGIS 10.0
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Druga metoda polegała na liniowym przeskalowaniu wartości wybranego 
wskaźnika TWI do przedziału wartości wilgotności objętościowej określonej w sze-
ściu profilach. Przeskalowania dokonano, przyrównując wartości względne wilgot-
ności objętościowej gleby oraz wskaźnika TWI. Wartości względne obliczono za 
pomocą minimalnych i maksymalnych wartości obu parametrów, określonych dla 
sześciu lokalizacji, zgodnie z równaniami:

gdzie: θW – względna wilgotność objętościowa gleby [-], θi – wilgotność objętościo-
wa gleby w punkcie i [%], θmax – wilgotność objętościowa profilu najwilgotniejszego 
[%], θmin – wilgotność objętościowa profilu najsuchszego [%], TWIW – względna 
wartość wskaźnika [-], TWIi – wartość wskaźnika w punkcie i [-], TWImin – mini-
malna wartość wskaźnika spośród wartości w komórkach rastra odpowiadających 
lokalizacji profili glebowych [-], TWImax – maksymalna wartość wskaźnika spośród 
wartości w komórkach rastra odpowiadających lokalizacji profili glebowych [-].

Stosowane równania są zbliżone do równań określających wilgotność efektyw-
ną gleby oraz wilgotność względną efektywną (Somorowska 2006). Różnią się spo-
sobem wyrażania zakresów zmian wilgotności.

Zakładając, że wartości względne, opisane równaniami 3.31 i 3.32 w danej ko-
mórce rastra  odpowiadają sobie, wartość wilgotności objętościowej dla tej komórki 
obliczono zgodnie z równaniem:

Takie przeskalowanie umożliwia również określenie wartości wilgotności poza 
analizowanym zakresem wartości ustalonym przez maksymalną i minimalną wil-
gotność pomierzoną w punktach. Wartości TWImin i TWImax stanowią stałe dla danej 
mapy wskaźnika, natomiast θmin i θmax zmieniają się w zależności od terminu pomia-
rowego. Mapę wskaźnika TWI przeskalowano za pomocą równania 3.33 procedurą 
Raster Calculator (Spatial Analyst Tools → Map Algebra). Następnie wilgotność 
objętościową w każdej komórce rastra przeliczono na zapas wody. Średni zapas 
wody w zlewni obliczono jako średnią wartość komórki rastra.

Dokonano obliczeń średniego zapasu wody w strefie aeracji w warstwie 0-50 cm 
dwoma metodami dla poszczególnych terminów pomiarowych. Wyniki porównano 
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θW = ( )θi – θmin

θmax – θmin

TWIW = ( )TWIi – TWImin

TWImax – TWImin

(3.31)

(3.32)

(3.33)θi = ( )TWIi – TWImin

TWImax – TWImin
 · (θmax – θmin ) + θmin



z wartościami obliczonymi za pomocą modelu HBV oraz z danymi z bazy GLDAS. 
Opracowano mapy zasobów wodnych strefy aeracji w miesiącach wiosennych, let-
nich i jesiennych w okresie badań terenowych metodą skalowania. Odwrotną pro-
cedurę, oceny zapasów wody w punktach za pomocą wartości średniej dla zlewni, 
zastosowano w rozdz. 6 w celu zobrazowania zróżnicowania przestrzennego zapasu 
wody na podstawie wyników modelowania.

3.3.4. Modelowanie stanu zasobów wodnych strefy aeracji 
z zastosowaniem modelu HBV

Do rekonstrukcji szeregów czasowych zasobów wodnych strefy aeracji, w celu 
oceny ich zmienności sezonowej i wieloletniej, zastosowano szwedzki model HBV 
(szw. Hydrologiska Byråns Vattenbalansavdelning). Został on opracowany w latach 
siedemdziesiątych XX w. w Instytucie Meteorologicznym i Hydrologicznym SMHI 
(szw. Sveriges Meteorologiska och Hydrologiska Institut) w Norrköping (Bergström, 
Forsman 1973; Bergström 1976). Początkowo był stosowany w prognozowaniu od-
pływu rzek skandynawskich. Od lat osiemdziesiątych XX w. został wykorzystany 
w ponad 40 krajach świata. Znalazł zastosowanie m.in. w prognozowaniu hydrolo-
gicznym, w badaniach zasobów wodnych, w ocenie wpływu użytkowania ziemi na 
stopień zagrożenia powodziowego, w ocenie wpływu zmian klimatu na zmienne hy-
drologiczne, w kontroli jakości danych hydrologicznych oraz w wydłużaniu ciągów 
pomiarowych (Haggström i in. 1990; Bergström i in. 2001; Lindström i in. 2002; 
Primožič i in. 2008; Sorman i in. 2009). Zakres jego zastosowań stale się zwiększa, 
podobnie jak liczba nowych wersji modelu. W hydrologii operacyjnej wdrażany był 
z powodzeniem w służbach hydrologicznych Szwecji i Polski (Kadłubowski i in. 
1996; Żelaziński i in. 1998).

W pracy zastosowano model HBV w postaci programu komputerowego HBV-
-light. Program ten został opracowany w 1995 r. na Uniwersytecie w Uppsali przez 
Seiberta (1996, 1997, 1999). Następnie był ulepszany przez autora m.in. na Uniwer-
sytecie Stanowym w Oregonie (ang. Oregon State University) oraz na Uniwersytecie 
w Sztokholmie. Ostatnia wersja programu, HBV-light 4.0.0.1, została opracowana 
na Uniwersytecie w Zurychu (Seibert, Vis 2012). Motywacją do opracowania HBV-
-light było stworzenie wersji modelu bardziej przyjaznej dla użytkownika, któ-
ra mogłaby być szeroko wykorzystywana zarówno w badaniach naukowych, jak  
i w edukacji. Algorytm modelu HBV-light jest zgodny z zastosowanym w wersji 
SMHI HBV-6 przez Bergströma (1992). HBV-light w badaniach naukowych został 
wykorzystany m.in. przez Pekárova i in. (2005) do oceny wpływu ekstremalnych 
zdarzeń opadowych na formowanie się odpływu ze zlewni, a także przez Steele-

Materiał badawczy i metody badań70



-Dunne i in. (2008) oraz Driessena i in. (2010) do oceny wpływu prognozowa-
nych zmian klimatu na odpływ rzeczny. Seibert i Beven (2009) zastosowali model 
HBV-light w analizach dotyczących szacowania odpływu w zlewniach niekontro-
lowanych.

Model HBV jest modelem konceptualnym relacji opad-odpływ. Składowe pro-
cesy obiegu wody opisywane są za pomocą uproszczonych równań matematycznych 
i zależności empirycznych. Parametry modelu identyfikowane są za pomocą meto-
dy optymalizacji. Jest to model deterministyczny o parametrach częściowo rozło-
żonych. Zlewnie duże i heterogeniczne pod względem topografii i pokrycia terenu 
mogą zostać podzielone na obszary cząstkowe.

W strukturze modelu HBV uwzględniono podział zlewni na trzy podsystemy, 
które stanowią fikcyjne zbiorniki: strefy aeracji, górny zbiornik wody podziemnej 
oraz dolny zbiornik wody podziemnej. Wejście do zbiornika strefy aeracji może 
stanowić opad deszczu lub woda z topniejącego śniegu. Część wody z tego zbior-
nika odparowuje do atmosfery, pozostała część po przekroczeniu pewnej granicz-
nej wartości pojemności zasila górny i dolny zbiornik wody podziemnej. Na pod-
stawie zasobności zbiorników wody podziemnej obliczany jest odpływ. Opisane 
procesy ujęte są w trzy podstawowe moduły obliczeniowe modelu: moduł pokry-
wy śnieżnej, moduł uwilgotnienia strefy aeracji oraz moduł generowania odpływu 
ze zlewni.

W programie HBV-light istnieje możliwość wyboru jednego z ośmiu typów 
modułu generowania odpływu ze zlewni. Różnią się one między innymi liczbą 
uwzględnianych zbiorników wody podziemnej. Wody podziemne mogą być repre-
zentowane przez jeden, dwa lub trzy zbiorniki. Powyżej opisano typ standardowy 
(ang. Standard Response Routine), w którym strefa saturacji podzielona jest na dwa 
zbiorniki: górny i dolny. W niniejszej pracy zastosowano moduł generowania od-
pływu z opóźnieniem (ang. Response Routine With Delay). Jest on zbliżony do typu 
standardowego, uwzględnia bowiem również dwa zbiorniki wody podziemnej. Róż-
ni się parametrami, które sterują dystrybucją wody ze zbiornika strefy aeracji do 
zbiorników strefy saturacji. Zastosowane opóźnienie, w sytuacji występowania dłu-
giego okresu bez zasilania, uniemożliwia całkowite wyczerpanie zbiorników wody 
podziemnej. Tym samym zapobiega to spadkowi symulowanego przepływu do 
wartości 0 m3·s-1. Skutkuje to lepszym dopasowaniem przepływu obserwowanego 
i symulowanego w okresach niżówek. Rysunek 3.23 przedstawia schemat systemu 
zlewni w modelu HBV-light podzielony na moduły obliczeniowe wraz z przypisany-
mi im parametrami. Model z modułem generowania odpływu ze zlewni z opóźnie-
niem uwzględnia łącznie czternaście parametrów. Zostały one opisane poniżej oraz 
zestawione w tabl. 3.12 w dalszej części rozdziału.
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Moduł pokrywy śnieżnej uwzględnia procesy akumulacji i topnienia śniegu. 
Opad atmosferyczny podlega podziałowi na opad w formie ciekłej i stałej w zależ-
ności od temperatury powietrza. Progowa wartość temperatury powietrza TT [°C], 
poniżej której opad występuje w postaci śniegu, jest ustalanym przez użytkownika 
parametrem modelu. Wartość tego parametru jest zwykle bliska 0°C. Opad w formie 
stałej pomnożony przez współczynnik korekcyjny wysokości opadu śniegu SFCF 
[-] jest akumulowany w postaci pokrywy śnieżnej do momentu, gdy temperatura po-
wietrza wzrośnie powyżej przyjętego progu. Topnienie śniegu jest obliczane metodą 
wskaźnikową stopień-dzień. Ilość wody pochodzącej z topnienia uzależniona jest 
od wzrostu temperatury powietrza oraz współczynnika CFMAX [mm·°C-1·doba-1] 
zgodnie ze wzorem:

gdzie: Hmelt – warstwa wody powstała w wyniku topnienia śniegu [mm·doba-1],  
T – temperatura powietrza [°C], TT – progowa wartość temperatury powietrza [°C], 
CFMAX – współczynnik, określający wielkość topnienia pod wpływem wzrostu 
temperatury powietrza o 1°C [mm·°C-1·doba-1].

Woda z topniejącego śniegu jest zatrzymywana w pokrywie śnieżnej, dopóki jej 
ilość nie przekroczy pewnej wartości granicznej w stosunku do ilości śniegu, okre-

Rys. 3.23. Schemat systemu zlewni wg modelu HBV-light
Oznaczenia symboli: TT, CFMAX, SFCF, CFR, CWR – parametry modułu pokrywy śnieżnej; 

FC, LP, BETA – parametry modułu uwilgotnienia strefy aeracji; PART, DELAY, ALPHA, K1, K2, 
MAXBAS – parametry modułu generowania odpływu z opóźnieniem

(3.34)Hmelt = CFMAX · (T – TT)
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ślonej parametrem CWH [-]. Gdy temperatura powietrza ponownie spadnie poniżej 
wartości progowej, ilość zamarzającej wody oceniana jest zgodnie z równaniem:

gdzie: Hrefreezing – ilość zamarzniętej wody [mm·doba-1], CFR – współczynnik zama-
rzania [-].

Moduł uwilgotnienia strefy aeracji opisuje procesy pionowego przepływu 
wody między atmosferą, strefą aeracji oraz strefą saturacji. Jest najważniejszym 
elementem modelu, decydującym o odpływie ze zlewni (Kadłubowski i in. 1996). 
Zbiornik strefy aeracji wypełniany jest wodą opadową oraz wodą z topniejącego 
śniegu. Jego pojemność jest ograniczona i równa wartości parametru FC [mm]. Pa-
rametr ten utożsamiany jest z polową pojemnością wodną gleby. Im większe są zaso-
by wodne zbiornika strefy aeracji, tym więcej wody alimentuje górny zbiornik wody 
podziemnej (rys. 3.24). 

Ilość wody zasilającej strefę saturacji obliczana jest na podstawie następujące-
go równania:

gdzie: P – opad atmosferyczny [mm], R – zasilanie strefy saturacji [mm], SM – zapas 
wody w strefie aeracji [mm], FC – maksymalny zapas wody w strefie aeracji [mm], 
BETA – współczynnik empiryczny, sterujący zasilaniem strefy saturacji [-].

Zależy ona od relacji między aktualnym zapasem wody w strefie aeracji a jego 
największą możliwą wartością. Dodatkowo relację tę modyfikuje parametr BETA 
[-]. Im jego wartość jest mniejsza, tym zasilanie wód podziemnych jest mniejsze. 
Z kolei przy wartości parametru równej zeru, zlewnia pozbawiona jest zdolności 
zatrzymywania wody w strefie aeracji i cały opad zasila wody podziemne.

Opróżnianie zbiornika strefy aeracji odbywa się również wskutek parowania. 
Wejściem do modelu są wartości ewapotranspiracji potencjalnej. Ewapotranspiracja 
aktualna obliczana jest jako funkcja zapasu wody w zbiorniku strefy aeracji i ewapo-
transpiracji potencjalnej. Jej wartość rośnie wraz ze wzrostem zasobności zbiornika, 
aż do osiągnięcia wartości potencjalnej. Wartość zapasu wody w strefie aeracji, po 
przekroczeniu której ewapotranspiracja osiąga wartość potencjalną, jest parametrem 
LP [-]. Zależność tę przedstawia rys. 3.25.

Trzeci moduł obliczeniowy opisuje procesy związane z formowaniem się od-
pływu ze zlewni (rys. 3.26). Jak już wspomniano w pracy zastosowano typ mo-
dułu formowania się odpływu z opóźnieniem. Strefa saturacji reprezentowana jest  
w modelu przez dwa zbiorniki – górny (SUZ) i dolny (SLZ), które zasilane są wodą 
ze strefy aeracji. Część zasobów wodnych strefy aeracji, określona parametrem 

(3.35)

(3.36)

Hrefreezing = CFR · CFMAX · (T – TT)
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PART [-], zasila górny zbiornik wody podziemnej. Pozostała część dzielona jest na 
liczbę dni ustaloną parametrem DELAY [doba] i stopniowo dodawana do zasobów 
dolnego zbiornika wody podziemnej. Na podstawie zasobności dwóch zbiorników 
wody podziemnej oraz współczynników recesji K1 i K2 obliczany jest odpływ ze 
zlewni. Odpływ z górnego zbiornika Q1 reprezentuje szybką składową odpływu  
i jest kontrolowany współczynnikiem K1 [doba-1]. Dodatkowo składowa może być 
modyfikowana współczynnikiem ALPHA [-], będącym parametrem modelu. Jego 
domyślna wartość wynosi zero. Odpływ z dolnego zbiornika Q2 sterowany jest 
przez współczynnik recesji K2 [doba-1]. Sumę składowych odpływu można zapisać 
następująco:

gdzie: QGW – odpływ z dwóch zbiorników wody podziemnej [mm·doba-1], SLZ – 
zasoby wodne w dolnym zbiorniku wody podziemnej [mm], SUZ – zasoby wodne  
w górnym zbiorniku wody podziemnej [mm], ALPHA – współczynnik modyfikujący 
wielkość odpływu z górnego zbiornika wody podziemnej [-], K1, K2 – współczyn-
niki recesji [doba-1].

Suma składowych odpływu jest następnie transformowana za pomocą funk-
cji wagowej, określonej parametrem MAXBAS [doba], dając hydrogram odpływu 
ze zlewni. Zadaniem funkcji wagowej jest rozłożenie wielkości odpływu w czasie 
zgodnie z wagami zależnymi od wartości parametru MAXBAS [doba]. W praktyce 

Rys. 3.24. Zależność zasilania strefy saturacji od 
zapasu wody w strefie aeracji w modelu HBV 
wg Bergströma i Forsmana (1973)

Rys. 3.25. Zależność ewapotranspiracji od za-
wartości wody w strefie aeracji w modelu HBV 
wg Bergströma i Forsmana (1973)
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większe wartości parametru skutkują tym, że kulminacja przepływu pojawia się póź-
niej i ma mniejszą wartość. Wpływ transformacji na uzyskiwany kształt hydrogramu 
odpływu został przedstawiony na rys. 3.27.

Danymi wejścia do modelu są dobowe wartości opadu atmosferycznego  
i temperatury powietrza oraz średnie dobowe bądź średnie miesięczne z wielole-
cia wartości ewapotranspiracji potencjalnej. W przypadku zastosowania średnich 
miesięcznych wartości ewapotranspiracji są one liniowo interpolowane do wartości 
dobowych. W procesie kalibracji i weryfikacji wymagane są dodatkowo dobowe 
wartości przepływu rzeki. Opcjonalnie można zastosować również średnie dobowe 
bądź średnie miesięczne z wielolecia wartości temperatury powietrza, które są wy-
korzystane w obliczeniach dobowych szeregów czasowych ewapotranspiracji poten-
cjalnej wg równania:

Rys. 3.26. Schemat zbiorników wody podziemnej uwzględniony w module generowania 
odpływu z opóźnieniem wg HBV-light Program Help, zmieniony (Seibert 2005)

Rys. 3.27. Przykład transformacji dla parametru MAXBAS = 5 wg Seiberta (2005)



przy założeniu:

gdzie: Epot – ewapotranspiracja potencjalna [mm], EpotM – średnia dobowa z wie-
lolecia ewapotranspiracja potencjalna [mm], T – temperatura powietrza [°C],  
TM – średnia dobowa z wielolecia temperatura powietrza [°C], CET – współczynnik 
korekcyjny [°C-1].

Jak już wspomniano zlewnia może zostać podzielona na obszary cząstkowe, 
co przedstawiono na rys. 3.28. Maksymalnie można wydzielić 20 obszarów cząst-
kowych. Każdemu z nich przypisuje się średnią wysokość w metrach n.p.m. Ist-
nieje również możliwość uwzględnienia położenia stacji meteorologicznych oraz 
wprowadzenia wartości wskaźników PCALT [%·100 m-1] i TCALT [°C·100 m-1], 
które określają zmiany wraz z wysokością, odpowiednio opadu i temperatury po-
wietrza. Ponadto w modelu można przygotować maksymalnie trzy różne zestawy 
parametrów związanych z podsystemami pokrywy śnieżnej i uwilgotnienia strefy 
aeracji. Dzięki temu model pośrednio uwzględnia przestrzenne zróżnicowanie po-
krycia terenu zlewni, od którego zależy przebieg procesów, m. in. akumulacji i top-
nienia śniegu, infiltracji oraz ewapotranspiracji. Każdemu z 20 obszarów cząstko-
wych, zróżnicowanych pod względem wysokości n.p.m., przypisuje się procentowy 
udział powierzchni, jaki można w jego obrębie scharakteryzować jednym z trzech 

Epot = (1 + CET(T – TM))EpotM

0 ≤ Epot ≤ 2EpotM

(3.38)

(3.39)
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Rys. 3.28. Schemat podziału zlewni w modelu HBV-light na obszary cząstkowe na podstawie wyso-
kości wraz z przyporządkowanymi im trzema zestawami parametrów modułu pokrywy śnieżnej (TT, 

CFMAX, SFCF, CFR, CWR) i uwilgotnienia strefy aeracji (FC, LP, BETA)



zestawów parametrów. Model uwzględnia również obecność zbiorników wodnych 
w zlewni przez określenie wysokości ich położenia i powierzchni, jaką zajmują.

W przypadku, gdy nie dokonuje się podziału zlewni, meteorologiczne dane 
wejściowe mogą charakteryzować przeciętne warunki w zlewni, wyrażone średnią 
ważoną z dostępnych stacji pomiarowo-obserwacyjnych. Podział zlewni na obszary 
cząstkowe umożliwia przyporządkowanie każdemu z nich innego szeregu czaso-
wego danych wejściowych. Wyjście z modelu ma charakter skupiony i stanowi je 
hydrogram przepływu. Ponadto uzyskiwane są dane ekwiwalentu wodnego śniegu, 
ewapotranspiracji potencjalnej i aktualnej, zasobów wodnych strefy aeracji oraz 
strefy saturacji.

Model HBV wymaga kalibracji, która w oryginalnej wersji modelu wykonywa-
na jest ręcznie metodą prób i błędów poprzez niewielkie korekty parametrów. Biorąc 
pod uwagę dużą liczbę parametrów modelu, poszukiwanie najlepszego zestawu wią-
że się z wieloma próbami. Wersja HBV-light została wzbogacona o automatyczną 
procedurę optymalizacyjną Monte Carlo. Metoda Monte Carlo jest szeroko stoso-
wana w różnych działach matematyki, a jej istotą jest przypadkowy wybór poszu-
kiwanej wartości. W modelu HBV-light kalibracja metodą Monte Carlo polega na 
losowym wielokrotnym doborze wartości parametrów. Użytkownik podaje liczbę 
iteracji oraz prawdopodobny zakres wartości parametrów w danych warunkach kli-
matycznych i hydrologicznych.

Okres wykorzystywany do kalibracji powinien obejmować co najmniej pięć lat 
i być zróżnicowany pod względem zdarzeń hydrologicznych. Ponadto ustalany jest 
okres tzw. „rozgrzewki” modelu (ang. warming-up period), który poprzedza właściwe 
obliczenia. Model wówczas pracuje, ale nie zapisuje wyników. Pozwala to wyelimi-
nować błędne wartości różnych zmiennych, które mogą pojawić się w początkowym 
etapie pracy modelu oraz ustanowić prawidłowe warunki początkowe. Okres „roz-
grzewki” określany jest zarówno dla kalibracji, jak i weryfikacji oraz symulacji.

Celem kalibracji jest znalezienie optymalnego zbioru parametrów, przy którym 
zgodność obserwowanych oraz symulowanych wartości przepływu jest największa. 
Poprawność przeprowadzonej kalibracji sprawdzana jest za pomocą współczynnika 
efektywności modelu Reff, współczynnika efektywności modelu z logarytmem Reff log, 
współczynnika determinacji R2 oraz średniej rocznej różnicy między odpływem ob-
serwowanym i symulowanym M:
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Reff = 1 –
∑(Qobs – Qsim)2

∑(Qobs – Qobs)2 (3.40)

Reff log = 1 –
∑(lnQobs – lnQsim)2

∑(lnQobs – lnQobs)2 (3.41)



gdzie: Qsim – przepływ symulowany [mm·doba-1], Qobs – przepływ obserwowany 
[mm·doba-1], Qsim – średni odpływ symulowany [mm], Qobs – średni odpływ obser-
wowany [mm], n – liczba dni, dla których wykonywane są obliczenia [-].

Współczynnik efektywności modelu Nasha-Sutcliffe’a (1970) Reff wskazuje na 
zgodność przepływu obserwowanego i symulowanego. Wartości zbliżone do jedne-
go świadczą o dobrym dopasowaniu dynamiki przepływów. Jednak nie jest on wraż-
liwy na systematyczne przeszacowanie lub niedoszacowanie modelu. Ze względu na 
obliczanie kwadratu różnicy między przepływami, może on nie uwzględniać złego 
dopasowania niskich przepływów (Legates, McCabe 1999). Poprzez transformację 
logarytmiczną współczynnika efektywności powstaje miara – Reff log. Jest ona bardziej 
wrażliwa na niezgodności przy niskich przepływach i może być stosowana do oceny 
poprawności modelu w ich zakresie. Kolejną miarą dopasowania jest współczyn-
nik determinacji R2, który informuje, jaka część zmienności przepływów obserwo-
wanych została wyjaśniona zmiennością przepływu symulowanego. Podobnie jak 
współczynnik Reff, nie jest on wrażliwy na systematyczne przeszacowanie lub niedo-
szacowanie wartości przepływu. Współczynnik R2 przyjmuje wartości z przedziału 
<0,1>. Z kolei współczynnik M określa różnicę między odpływem obserwowanym  
a symulowanym, wyrażoną w milimetrach na rok. Wartość równa zeru wskazuje na 
dobre dopasowanie wielkości odpływu, a tym samym zapewnia poprawne odtwo-
rzenie pozostałych składowych bilansu wodnego. Wartości poniżej zera informują  
o przeszacowaniu, a powyżej zera – o niedoszacowaniu modelu.

Nie istnieją ustalone wartości graniczne miar zgodności (rozbieżności) prze-
pływu obserwowanego i symulowanego, powyżej których przyjmuje się, że model 
jest poprawny. Tabl. 3.9 przedstawia zakresy zmienności stosowanych miar zgodno-
ści oraz ich wartości, przy których zakłada się idealne dopasowanie danych obser-
wacyjnych do wyników symulacji.

Ponadto w ocenie poprawności modelu, obok wymienionych miar statystycz-
nych, zastosowano metody graficzne. Są one bardziej subiektywne i polegają na oce-
nie wizualnej. Umożliwiają łatwe uchwycenie systematycznego przeszacowania lub 
niedoszacowania modelu. Przed zastosowaniem skalibrowanego modelu zalecane 
jest przeprowadzenie jego weryfikacji na okresie niezależnym. 

Rysunek 3.29 przedstawia schemat zastosowania modelu HBV-light do rekon-
strukcji szeregów czasowych zasobów wodnych strefy aeracji w zlewni Liwca. Wy-
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R2 = 
(∑(Qobs – Qobs)(Qsim – Qsim))2

∑(Qobs – Qobs)2 ∑(Qsim – Qsim)2

M =   · 365
∑(Qobs – Qsim)

n

(3.42)

(3.43)
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różniono trzy etapy postępowania: kalibrację, weryfikację oraz symulację. Dobra 
ocena skuteczności modelu w danym etapie pozwalała na zastosowanie go w kolej-
nym. Opis symboli zastosowanych na schemacie znajduje się w tekście. Wstępnym 
etapem pracy, nieuwzględnionym na schemacie, było wydzielenie w zlewni obsza-
rów cząstkowych na podstawie klas wysokości oraz analiza dostępnej serii danych 
przepływu Liwca w profilu Łochów z wielolecia 1980-2011, niezbędnych w proce-
sie kalibracji i weryfikacji modelu.

Tablica 3.9
Zakresy zmienności oraz wartości przy idealnym dopasowaniu stosowanych miar zgodności. 

Oznaczenia symboli: Reff – współczynnik efektywności modelu, Reff log – współczynnik 
efektywności modelu z logarytmem, R2 – współczynnik determinacji, M – roczna różnica 

między odpływem obserwowanym a symulowanym

Miara zgodności Zakres zmienności Wartość przy idealnym dopasowaniu

Reff -∞ – 1 1

Reff log -∞ – 1 1

R2 0 – 1 1

M -∞ – +∞ 0

Rys. 3.29. Schemat zastosowania modelu HBV-light do rekonstrukcji 
szeregów czasowych zasobów wodnych strefy aeracji w zlewni Liwca



Dokonano podziału zlewni Liwca na obszary cząstkowe na podstawie nume-
rycznego modelu terenu SRTM (rys. 3.30). Wydzielono pięć stref. Zakresy ich wy-
sokości, średnią wysokość oraz powierzchnię, jaką zajmują w zlewni, przedstawiono 
w tabl. 3.10. Jako wartości wskaźników PCALT i TCALT przyjęto odpowiednio 
10%·100 m-1 oraz 0,6°C·100 m-1. Ponadto w modelu zadeklarowano obecność zbior-
ników wodnych, zajmujących 0,37% powierzchni zlewni po profil wodowskazowy 
w Łochowie wg MPHP.

W procesie kalibracji i weryfikacji modelu zastosowano następujące dane wej-
ściowe:
•	 dobowe wartości opadu atmosferycznego ze stacji Siedlce PSIEDLCE [mm],
•	 dobowe wartości temperatury powietrza ze stacji Siedlce TSIEDLCE [°C],
•	 średnie miesięczne z wielolecia wartości ewapotranspiracji potencjalnej, 

obliczone na podstawie danych z bazy MARS EpMARS [mm],
•	 dobowe wartości przepływu Liwca w profilu wodowskazowym Łochów, prze-

liczone na warstwę odpływu HŁOCHÓW [mm].
Do kalibracji wybrano przepływy w latach 2007-2011. Rok hydrologicz-

ny 2006 stanowił „rozgrzewkę” modelu. Długość okresu „rozgrzewki” została 
ustalona na podstawie literatury oraz własnych doświadczeń w pracy z modelem. 

Rys. 3.30. Podział zlewni Liwca na obszary cząstkowe wydzielone na podstawie klas wysokości
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